MX49/MX61 Total Librarian Handbuch

Vielen Dank fiir die Verwendung von MX Total Librarian!

Dies ist eine komplette Librarylosung flir den Yamaha MX49/MX61 Synthesizer. Es ist
eine Verwaltung fir Voices, Drum Kits (Schlagzeug-Voices) und Performances. Diese
Anwendung hilft IThnen bequem bei der Organisation Ihrer Soundsammlung! Es
beinhaltet auch eine komplette Editorumgebung, da es alle verschiedene MX Editoren
integriert.

Zu den Hauptfeatures zdhlen:
e Liest (und wandelt) Voices, Schlagzeug-Voices und Mixes von allen nativen XF / XS
Serie Dateien
o Motif XF: X3A, X3V
o Motif XS: XO0A, X0V, XOE
o Motif Rack XS: X1E
o S90 XS/S70 XS: X2A, X2V
o MOX6/MOX8: X4A, X4V
o MX49/MX61: X5A

e Verwendet eine integrierte Abhangigkeitsverfolgung. Wenn Sie User-Voices oder
User-Schlagzeug-Voices sortieren oder ordnen, dann werden alle Performances, in
denen diese vorkommen automatisch aktualisiert. Wenn Sie eine Performance in
eine neue Datei einfligen, werden alle User-Voices oder User-Schlagzeug-Voices
ebenfalls kopiert. Damit wird die Konsistenz der Library zu gewahrleistet.

e Ermdglicht das einfache Anhéren von Patches, indem Sie sie in den
Bearbeitungspuffer des Synthesizers senden.

e Bietet eine leicht zu navigierende, Explorer ahnliche, Benutzeroberflache. Banken
und Patchsammlungen sind wie Ordner und Patches sind wie Dateien.

e Unterstitzt einfaches Einfligen von Patches per "Drag and Drop"!

e Unterstitzt fiir jeden Patch die Bearbeitung der Bezeichnungen, Auswahl der
Kategorie und Bearbeitung des Kommentars.

e Ermdéglicht das Suchen von Patches nach Bezeichnung und Kategorie.

e Unterstlitzt "Total Library"-Dateien, die Performances, User-Voice-Banken und
User-Schlagzeug-Voice-Banken und enthalten.

e Unterstlitzt "Voice Library"-Dateien, die eine unbegrenzte Anzahl an Voices und
Schlagzeug-Voices enthalten.

e Ermdglicht es mehrere Library-Dateien jeglicher Art gleichzeitig zu 6ffnen.

Bitte beachten Sie auch die Kontaktinformation und den Anhang am Ende
dieses Dokuments.
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1. Verbindungen einrichten

Wenn Sie diese Anwendung zum ersten Mal ausfiihren, sollten Sie das folgende Meni
auswahlen Setup>MIDI Setup und dort die MIDI-Ports angeben, an denen Sie Ihren
Synthesizer angeschlossen haben. Driicken Sie nach Auswahl der richtigen Anschliisse
[OK]. In der Statusleiste erhalten Sie dann die folgende Bestatigungsnachricht:
"MX49/MX61 connected", welche besagt, dass Ihr Synthesizer korrekt angeschlossen
ist.

Alternativ kdnnen Sie auch Setup—>Autoconnect ausfiihren, dieser Meniibefehl versucht,
die Ports, an denen Sie Ihren Synthesizer angeschlossen haben, automatisch zu erken-
nen!

2. Erstellen einer neuen Library-Datei
"Total Librarian" unterstitzt zwei verschiedene Arten von Library-Dateien:

e "Total Library"-Dateien
Diese Dateien enthalten alle Benutzerbanken des Synthesizers. Sie unterstitzen
User-Voices, User-Schlagzeug-Voices (Drum Kits) und Performances. Ihre
Kapazitat ist auf die Kapazitat des Speichers im Synthesizer begrenzt, da sie
dazu bestimmt sind, die gleiche Struktur wie dieser zu haben.

e "Voice Library"-Dateien
Diese Dateien kdnnen eine unbegrenzte Anzahl von Voices und Schlagzeug-
Voices enthalten. Sie dienen als Sammlung dieser Voices, von denen sie
ausgewahlt werden kénnen, um sie in einer "Total Library"-Datei einzufligen
oder direkt zum Synthesizer zu senden.

3. Fiillen Sie die neue Library-Datei mit Daten

Wenn Sie eine neue Datei erstellt haben, dann kénnen Sie Daten von einer nativen Mo-
tifdatei importieren (Meni: File>Import Native File) oder Sie empfangen die Daten di-
rekt aus dem Speicher des Synthesizers (Menu: Edit>Receive All). Falls Sie nur mit ei-
ner "Total Library"-Datei arbeiten, so kénnen nur die User-Banken empfangen werden.
Preset-Banken kdénnen nur in einer "Voice Library"-Datei aufgenommen werden und
kénnen dann natirlich in eine Benutzerposition einer "Total Library"-Datei kopiert
werden.

4. Ihre Daten bearbeiten
Siehe Kapitel 2 und 3.

5. Durchsuchen und Uberwachen der Patches

Wadhrend Sie eine Library-Datei - gefillt mit Patches - gedffnet haben, kénnen Sie im-
mer die Taste "Enter" (Eingabe) dricken und der gewahlte Patch wird zum
Bearbeitungspuffer des Synthesizers (bertragen. Dies geschieht zum Zwecke der
,Vorschau' und erlaubt es Ihnen, den gewahlten Patch anzuhdren, ohne tatsachlich den
User-Speicher des Synthesizers zu liberschreiben.

6. Senden von Daten an den Synthesizer oder in eine Datei

Wenn Sie mit der Bearbeitung einer Library fertig sind, kénnen Sie Ihre Anderungen in
einer Datei speichern (Menl: File>Save As) oder, wenn Sie mit einer "Total Library"-
Datei arbeiten, direkt an den Synthesizer senden (Menl: Edit>Transmit All).
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Library-Dateien werden in "Total Librarian" in einer vertrauten Explorerdhnlichen
Oberfldche prasentiert. Links sehen Sie eine Verzeichnisstruktur und auf der rechten
Seite sehen Sie eine "Dateiliste". "Ordner" sind Bank- bzw. Ordnersammlungen und
"Dateien" sind die Patches in der Library. Patches sind Voices, Drum-Kits oder
Performances.

e — o

A3EH R 128 Q9 23 BY
Ll |
] FACTORY.allmx EEE
I Total Library Name Number Type Tempo Comments =)
4 |8 Voices [ MxCategary 001 (AD1) %0
/) USER [ TWub You 002 (A02) Layer 7
N DRASR ] Sirius 103 (A03) Layer 130 o
B Peshormarices [ Eastslicer 004 (404) spit 100
. PERE ] XX Rock 005 (405) Layer 104
o) Baked %X 006 (A06] Layer 115
[ Funklt! w07 (a0 Layer 106
@ TranceGale 008 (A0E] Split 134
@ Rip Bell 009 (A09) Layer 60
[ EellyDance 010 (A0} Splt 115
@ Jam Hood 011 (All] Layer i J
B Fock n Syn 012 (A12] Layer 112
Iﬁ OP Show 013 (a13] Layer 104
[l @ Night 014 (Al4) Layer %0
[ PsyTmehw 015 (415) Splt 134
[ CuricusBot 016 (A16) Layer 20
@ Fariz M 0117 (BO1) Layer 106
m Wcbbling 018 (BUZ) Layer 193
@ FolaryWind 019 (BO3) Layer 105
@ Yah-Yo-lzh 020 (BO4) Layer 90
] Practise X 021 (BIS) Split a
wd] &na Warm 022 (BOS) Layer a0
[ Mentuns 023 (B07) Layer 90
[w] TraneyPizr 0174 (BO8) Spit 134
[ Eug Breath 025 (BLY) Layer 122
@ Dreamer 026 (B10) Layer 70
[ Coriander 027 (B11) Layer 90
[ DarkeAfrica 028 (B12) Layer a
TN oan s aso tay ; 22 x
Ready MXA2/MKEEL connected

Die meisten der verfligbaren Befehle fiir die Bearbeitung existieren als Menipunkte und
werden spater beschrieben. Die Befehle, die nicht als Menupunkte vorhanden sind:

Patch bearbeiten

Bezeichnung (Name) bearbeiten:
Gewdlinschten Patch auswahlen und F2 driicken. Es wird ein Editorfeld angezeigt und
Sie kénnen den Kommentar bearbeiten.

Kategorie (Category) bearbeiten:
Gewlinschten Patch auswdhlen und F2 dricken oder mit der linken Maustaste
doppelklicken. Es wird ein Dropdownmenl angezeigt und Sie kdnnen die Kategorie
andern.

Kommentar (Comment) bearbeiten:
Gewlinschten Patch auswahlen und F2 dricken oder mit der linken Maustaste
doppelklicken. Es wird ein Editorfeld angezeigt und Sie kénnen den Kommentar
bearbeiten.

@ Mmh Choir 011 (A11) PAD

@ GospelVelo 012 (A12) PAD

Hum Choir 013 (A13) PAD Great choir scund1
@ TenorMaxEx 014 (A14) WND

@ AltoVibVel 015 (A15) WND
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Patch sortieren

Wenn Sie auf den Spaltenkopf einer Patch-Liste klicken, werden die Patches nach dieser
Spalte geordnet. "Total Librarian" unterstiitzt die Sortierung von Patches nach
Bezeichnung, Kategorie und Kommentar.

Beachten Sie, dass die Sortierung von Patches einer Bank den internen Speicher des
Synthesizers nicht beeinflusst. Um die sortierten Patches auf den Synthesizer zu
Ubertragen missen Sie den "Transmit"-Befehl verwenden (Meni: Edit->Transmit All).

Drag ‘n’ Drop: Patch Neuordnung leicht gemacht

Dies ist ein besonderes Merkmal von "Total Librarian”, welches die Neuordnung von

Patches zu einem Kinderspiel macht. Haben Sie damit gekampft, wie Sie die Reihenfolge
der Voices, Performances usw. anordnen?

Wadhlen Sie einfach die Patches, die Sie verschieben mdchten (Mehrfachauswahl wird
unterstitzt) und verschieben Sie diese zu der gewlinschten Stelle. Speichern Sie die
Library-Datei und Gbertragen die Patches auf den Synthesizer.

Patch Number Category
@ Marimba DX 001 (A01) Kb:FM
R&E Soft 002 (A02) Kb:EP

TE Rock Grand Piano 003 (AD3) Pn:Modern
& FullDraw/CVibrato 004 (A04) Or:TnWhl
T& Steel String AFL82 005 (A05) GuAGtr
TE |Dual Coil 80 Clean 006 (A06) GtE.Cln
7% Finger PBs AFL 007 (AOT) Bs:EBazs
@ 2 Electrics AF1&2 008 (A08) GtECln
@ Old Blues 005 (A09) Pn:Vintage
d7 Alternator 7E Rock Grand Piano nWhl

o Medium Large B 01 S0l T

#7 Big Syn T Steel String AF182
\ERCLVRELE TE Dya| Coil 80s Clean

Active P % Finger PBs AF1

Crunchy Guitar 015 (A15) GhE.Dst
@ Angel Eyes 016 (Al6) Pd:Choir
CP 197 017 (BO1) Pn:Vintage
=5 : Sl . )
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"Total Librarian" besitzt eine komfortable Arbeitsumgebung, von der aus Sie alle
verschiedenen Editoren des "Complete Pack" aufrufen kénnen.

Auf die installierten Editoren haben Sie sowohl aus dem Meni Editors, als auch von der
Editors Symbolleiste, heraus Zugriff. Wenn ein Menlpunkt eines Editors ausgegraut
erscheint, so bedeutet das, dass der entsprechende Editor nicht auf Ihrem System
installiert ist. Fihren Sie in diesem Fall das Setupprogramm erneut aus.

Beispiel eines Editor Einsatzes

Nehmen wir an, Sie haben eine Total Library-Datei geéffnet, welche einige Performances
enthalt. Sie koénnen den Performance-Editor benutzen, um die in dieser Datei
enthaltenen Performances zu bearbeiten. Klicken Sie mit der rechten Maustaste auf die
Performance, die Sie andern mochten und wahlen Sie Edit aus dem Kontextmeni. Die
Daten des Patches werden an den Bearbeitungspuffer des Synthesizers gesendet und
der Editor offnet sich automatisch mit den Daten der Performance, die Sie bearbeiten
maochten!

AnschlieBend kénnen Sie im Performance Editor mit der Bearbeitung der Performance
beginnen.

Sobald die Einstellungen der Performance fertig sind, kdnnen Sie diese zur Total Library-
Datei zurlick senden:

Nach einem Rechtsklick auf die Performance wdhlen Sie Receive from Edit Buffer aus
dem Kontextmeni des Patches. Speichern Sie die "Total Library"-Datei und Ihre neue
Performance ist gesichert!
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File (Datei)

New (Neu)
Erstellt ein neues Dokument (entweder eine neue "Total Library"-Datei oder eine
neue "Voice Library"-Datei).

Open (Offnen)

Mit diesem Befehl kénnen Sie eine zuvor gespeicherte "Total Library"- oder
"Voice Library"-Datei laden. Beachten Sie, dass mehrere Library-Dateien zur
gleichen Zeit getéffnet werden kdénnen.

Save (Speichern)
Mit diesem Befehl kénnen Sie die aktuelle Library in eine Datei speichern.

Save As (Speichern als)
Wie Save (Speichern), Sie werden jedoch nach einem Dateinamen gefragt.

Close (SchlieBen)
SchlieBt die aktive Library-Datei.

Close All (Alle schlieBen)
SchlieBt alle gedffneten Library-Dateien.

Presets (Vorgaben)

Hier kénnen Sie eine fertige "Total Library"-Datei mit den werkseitigen Banken,
sowie eine "Voice Library"-Datei, mit allen Preset-Voices und Preset-Schlagzeug-
Voices laden!

Import Native File (Native Datei importieren)

Dieser Befehl importiert Patches von nativen Dateien. Es kdnnen Voices,
Schlagzeug-Voices und Performances von nativen MX Dateien (X5A) gelesen
werden. Mehr noch, es kénnen Voices, Schlagzeug-Voices und Mixes aus nativen
Dateien aller XF/XS Serien importiert werden (Motif XF, Motif XS, S90 S70 XS,
Motif-Rack XS und MOX6/MOX8 Dateien werden unterstiitzt).

Import Total/Voice Library (Total/Voice Library importieren)

Dieser Befehl importiert "Total Library"- oder "Voice Library"-Dateien, welche
mit den unterschiedlichen Versionen von "Total Librarian" fir XF/XS Synthesizer
erzeugt wurden! Dies ermdglicht eine einfache Ubertragung von Patches
zwischen Motif XF, Motif XS, S90 S70 XS, Motif-Rack XS, MOX6/MOX8 und
MX49/MX61!

Export Cubase Patch Script File

(In Cubase Patch-Script Datei exportieren)
Erzeugt eine Cubase™ Patch-Script-Datei aus der aktuell gedéffneten "Total
Library". Die User-Voicenamen werden nach den Voices der Library-Datei
benannt!

Export Sonar Instrument File (Windows only)

(Sonar Instrument Definition erzeugen)
Erzeugt eine Sonar™ Instrument Definition Datei aus der aktuell gedffneten
"Total Library". Die User-Voicenamen werden nach den Voices der Library-Datei
benannt!
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Export Patches Name (Bezeichnung der Patches exportieren)

Mit diesem Befehl kénnen Sie eine Liste der Bezeichnungen der Patches in einer
Textdatei speichern. Exportierte Daten kdénnen dazu verwendet werden, um
Ausdrucke Ihrer Live-Set-Listen zu erstellen, oder einfach nur um den Inhalt der
Library-Dateien zu dokumentieren.

Recent Files (Letzte Dateien)
Eine der letzten acht bearbeiteten Dateien kann hier schnell geladen werden.

Exit (Beenden)
Beendet die Anwendung.

Edit (Bearbeiten)

Undo (Riickgdngig) )
Dieser Befehl macht die letzte Anderung in der aktiven Datei riickgangig.

Redo (Wiederherstellen)
Eine rickgangig gemachte Aktion wird wieder ausgefihrt.

Search (Suchen)

Indem sie die Bezeichnung oder einen Teil davon eingeben, kdnnen Sie einen
bestimmten Patch in Ihrer Library suchen. Wenn Sie doppelt auf das Ergebnis
klicken wird der Patch in der aktiven Library-Datei ausgewahlt.

Remove Duplicates (Duplikate entfernen)

Wenn Sie viele Patches aus verschiedenen Quellen importiert haben, dann
kénnen vielleicht einige identische Patches in Ihrer Library existieren. Dieser
Befehl sucht Duplikate und ermdglicht es Ihnen auszuwahlen, welche der
Duplikate Sie léschen moéchten. Um die Konsistenz der Library zu gewahrleisten
wird, falls Sie einen doppelten Patch I6schen, welcher von einem anderen Patch
verwendet wird (hat einen Elternteil, d.h. eine Voice wird von einer Performance
verwendet), der verbliebene Patch aktualisiert, um auf den nicht geléschten zu
zeigen.

Select All (Alle auswahlen)
Mit diesem Befehl kdénnen Sie alle Patches einer Bank oder Patchsammlung
auswahlen.

Invert Selection (Auswahl umkehren)
Kehrt die aktuelle Auswahl um. Hebt die Wahl der ausgewéahlten Patches auf und
wahlt die nicht ausgewahlten.
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Transmit All (Alles iibertragen)
Mit diesem Befehl kdnnen Sie alle Banken der Library-Datei (User-Voices,
Schlagzeug-Voices und Performances) zum Synthesizer Ubertragen Sie kénnen
zu jeder Zeit auswahlen, welche Banken Sie Ubertragen wollen. Bitte beachten
Sie, dass dieser Befehl nur fir

"Total Library"-Dateien  [* o o) . |
funktioniert, da nur diese g '

Dateien die gleiche Struktur wie Selact banks 1o fransmits Al Mone
der internen Speicher des
Synthesizers haben.

[¥] USER
[¥] DR:USR
[V] PERF

Receive All (Alles empfangen)
Dieser Befehl funktioniert flr
beide Library-Formate. Wenn die
derzeit aktive Library-Datei eine
"Total Library" ist, dann kann es
alle Benutzerbanke (User Normal
Voices, Schlagzeug-Voices, Per-
formances) aus dem Synthesizer
empfangen. Wenn die derzeit
aktive Library eine "Voice
Library" ist, dann konnen nur
User Normal Voices und User | ok || cancel |
Schlagzeug-Voices empfangen
werden. Sie kdnnen

auswahlen, welche 7 - —
Banke Sie empfangen Receive All ‘mu

wollen.
PERF:029 (B13) PlanetRock
Patch
Siehe Kapitel 4 " = |

(Patch-Menlibefehle).

Cancel

(Anzeige)

Up Folder (Eltern-Ordner)

Einer der gréBten Vorteile der Library-Dateien ist, dass sie ihre Daten in einer
Explorerahnlichen Oberflache prasentieren. Dieser Befehl bewegt den Cursor
zum oberen "Ordner", das kann eine Bank-Sammlung oder eine Sammlung von
anderen "Ordnern" sein.

Editors Toolbar (Editoren Symbolleiste)
Ein-oder Ausblenden der Symbolleiste mit den Editoren-Icons.

Editors (Editoren)

Voice Editor
Startet den "Voice Editor".

Drum Kit Editor
Startet den "Drum Kit Editor".

Performance Editor
Startet den "Performance Editor".
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MIDI Setup

Geben Sie hier die MIDI-In und MIDI-Out Ports ein, mit denen Ihr Synthesizer
verbunden ist. Sie kdnnen die Gerate-ID (in der Regel ist es 1), so wie auch das
Intervall (in Millisekunden) &ndern. Dieses ist zustandig, wenn mehrere
systemexklusive Nachrichten an den Synthesizer gesendet werden. SchlieBlich
kénnen Sie zwei zusatzliche Anschliisse wahlen: Einen zusatzlichen MIDI-
Eingang, an dem ein externes MIDI-Keyboard oder Controller verbunden ist und
einen zusatzlichen MIDI-Ausgang (extern angeschlossener Klangerzeuger), an
den die Eingabedaten gesendet werden (MIDI Thru-Funktionalitat).

~ e : :

MX Setup

MIDI In
| Yamaha MX49/Mx61-1 - |

MIDI Qut
| Yamaha Mx43/Mx61-1 - |

Device Id
£ d
Bulk Dump Interval

25 msec

Auxiliary Ports

WL

MIDI In

[(none)

MIDI Qut

| (none)

Autoconnect (Automatisch verbinden)

Anstelle der manuellen Definition der MIDI Ports, mit denen Ihr Synthesizer
verbunden ist, kann dieser Befehl verwendet werden, damit das Programm
automatisch die Ports erkennt.
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¢ Preferences (Einstellungen)
Hier kdnnen Sie die grundlegende Anwendungskonfiguration einstellen.

{ ™

Startup Options

When the application starts:
lOpen last loaded library hd

Dependency Cptions

[¥] Enable Dependency Coloring
Patch is & Child (is used by other Patches)

Patch is & Parent {uses other Patches)

|
Patch is both Child and Parent

Startup Options: (Startoption)
Wahlen Sie, was beim Start von "Total Librarian" geschehen soll.
Folgendes kann eingestellt werden:

o Show empty environment (mit leerer Umgebung starten)

o Create empty Total Library (leere Total Library)

o Create empty Voice Library (leere Voice-Library)

o Open last loaded Library (zuletzt gedffnete Library laden).

Dependency Options: (Abhdngigkeitsoptionen)

"Total Librarian" unterstitzt die Verfolgung von Abhangigkeiten. Das bedeutet.
dass es weil3, wenn ein Patch andere Patches nutzt oder wenn er selber durch
andere Patches verwendet wird.

Laut der MX Architektur:

o Performances kdnnen User-Voices und User-Schlagzeug-Voices verwenden.

o User-Voices und User-Schlagzeug-Voices kénnen von Performances
verwendet werden.

In der "Total Librarian" Terminologie: Wenn ein Patch einen anderen Patch
nutzt, heiBt es "parent (Eltern)"-Patch, und wenn er von einem anderen Patch
verwendet wird, "child (Kind)"-Patch.

Enable Dependency Coloring (Abhdngigkeitseinfarbung erlauben)

Hier konnen Sie die Einfarbung der Patches in Abhdngigkeit vom Status
ermdglichen. Die Farben kénnen beliebig gewahlt werden.

Standard ist:

child (Kind)-Patch: rot.

parent (Elteren)-Patch: blau.

Sowohl child, als auch parent-Patch: lila.

10
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Window (Fenster)

Cascade (Kaskade)
Setzt alle offenen Fenster kaskadierend auf ihre Standardposition.

Tile (Nebeneinander)

Positioniert alle offenen Fenster nebeneinander, Sie sehen alle gedffneten
Fenster auf einmal. Die Fenster werden in der GréBe angepasst und fiillen den
gesamten Arbeitsbereich aus.

Minimize All (Alle verkleinern)
Verkleinert alle offenen Fenster.

Restore All (Alle wiederherstellen)
Stellt alle minimierten Fenster wieder her.

Close All (Alle schlieBen) )
SchlieBt alle gedffneten Dateien. Wenn Anderungen an Dateien vorgenommen
wurden, so werden Sie aufgefordert, diese zuerst zu speichern.

Previous (Zuriick)
Aktiviert das vorherige Fenster.

Next (Weiter)
Aktiviert das nachste Fenster.

Open Windows List (Liste der gedffneten Fenster)
Alle gedffneten Fenster erscheinen als Menupunkte.

Help (Hilfe)

Manual (Handbuch)
Zeigt dieses Handbuch.

About (Uber)
Zeigt nutzliche Informationen Gber das Programm. Dieser Befehl tUberprift auch,
ob eine neue Version des Programmes verfligbar ist.

Product Page (Produktseite)
Zeigt der Produktseite, von wo Sie die neueste Version herunterladen kénnen.

11
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Wenn Sie im Hauptmenl Edit>Patch wdhlen oder einfach einen Rechtsklick auf den Patch
ausfihren, so wird das folgende Menl angezeigt.

MName Number Type Tempc
i) MXCategory 001 (A01) 90

LR LYY LI Il 74

o Siriud Send to Edit Buffer Enter 130
m' Eastq Receive from Edit Buffer Ctrl+R 100
g Xxx| Edit Ctrl+E A
| Bake 115
 Funk Send Program Change F3 106
ld Tran¢ o Transmit Ctrl+Right 134
lg] it @ Receive Ctrl+ Left 50
] Belly 115
il Jam | Transmit Child Patches 77
] Rock Receive Child Patches 112
| DP SI 104
) @ Ni Initialize Ctrl+1 90
@ PsyTi Rename 134
] Curic Delete Del 80
i Paris 106
w Wob 2 Copy Ctrl+C 193
i Rotal Paste Ctrl+V 105
wi] Yah-T L 80
au] Pract e . a0
) A Remove Duplicates... a0
) Mor &? Properties 50
aut| Trane prms N—— — 134
] Bug Breath 025 (B09) Layer 122

Patch Menu (Patch Menii)

e Send to Edit Buffer (An den Bearbeitungspuffer senden)
Sie kénnen den ausgewahlten Patch an den Bearbeitungspuffer des Synthesizers
senden, aber nur um ihn anzuhéren - es erfolgt keine Anderungen des internen
Speichers des Synthesizers. Wenn der entsprechende Editor gedffnet ist,
empfangt dieser die gesendeten Daten automatisch.

e Receive from Edit Buffer (Vom Bearbeitungspuffer empfangen)
Mit diesem Befehl empfangen Sie die Daten aus dem Bearbeitungspuffer des
Synthesizers, um sie im aktuell gewdhlten Patch der Library-Datei zu nutzen.

e Edit (Bearbeiten)
Dieser Befehl sendet den gewdhlten Patch zum Bearbeitungspuffer und startet
den entsprechenden Editor, um den Patch zu bearbeiten.

e Send Program Change (Programmwechsel senden)
Dieser Befehl sendet einen Programmwechsel-Befehl an den Synthesizer, so
dass der in der Library gewdhlte Patch auch im Synthesizer ausgewahlt wird.

12
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Transmit (Senden)

Diesen Befehl gibt es nur in Patches von "Total Library"-Dateien. Jeder Patch in
einer "Total Library" reprasentiert einen Ort im Speicher des Synthesizers. Mit
diesem Befehl kdénnen Sie die ausgewahlten Patches an ihre entsprechende
Position in den Speicher des Synthesizers Ubertragen. Dieser Speicher wird
dabei Uberschrieben. Wenn die Ubertragenen Patches Kind-Patches besitzen,
dann wird Sie "Total Librarian" nach der Ubermittlung fragen, ob auch diese
Patches gesendet werden sollen.

Receive (Empfangen)

Diesen Befehl gibt es nur in Patches von "Total Library"-Dateien. Die aktuell
ausgewahlten Patches in der Library erhalten die Daten von den
entsprechenden Positionen des Speichers im Synthesizer. Wenn die
empfangenen Patches Kind-Patches besitzen, dann wird Sie "Total Librarian"
nach der Ubermittlung fragen, ob auch diese Patches empfangen werden
sollen.

Transmit Child Patches (Kind-Patches senden)

Diesen Befehl gibt es nur in Patches von "Total Library-Dateien" welche zu
Performances gehoren. Sie kdnnen die Kind-Patches der ausgewahlten Per-
formances senden. Hiermit wird der Zusammenhang im Speicher des
Synthesizers sichergestellt.

Receive Child Patches (Kind-Patches empfangen)

Diesen Befehl gibt es nur in Patches von "Total Library"-Dateien. welche zu
Performances gehdren. Sie kénnen die Kind-Patches der ausgewdhlten Per-
formances empfangen. Hiermit wird der Zusammenhang mit der "Total
Library-Datei" sichergestellt.

Initialize (Initialisieren)
Dieser Befehl initialisiert die ausgewahlten Patches auf ihren Standardwert.

Rename (Umbenennen)
Mit diesem Befehl kénnen Sie die Bezeichnung des ausgewdhlten Patches
andern.

Delete (Loschen)

Dieser Befehl l6scht die ausgewahlten Patches. Bei "Total Library"-Dateien
wird der Platz geleert. Bei "Voice Library"-Dateien werden die Voices
vollstandig aus der Datei entfernt.

Copy (Kopieren)

Dieser Befehl kopiert die ausgewahlten Patches in die Zwischenablage. Wenn
die kopierten Patches Kind-Patches besitzen, dann werden diese ebenfalls in
die Zwischenablage kopiert.
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e Paste (Einfiigen)
Sie kénnen zuvor kopierte Patches und ihre Kind Patches einfligen. Wenn Sie
Patches in eine "Total Library" einfigen dann werden die ausgewahlten
Patches in der Datei mit denen aus der Zwischenablage Uberschrieben.
Ist kein Patch in der Zielbank ausgewahlt, so wird in den ersten Platz der Bank
kopiert.
Wenn der kopierte Patch Kind-Patches hat, dann werden diese, beginnend mit
dem ersten freien Platz in der Zieldatei, ebenfalls kopiert.
Dies macht die Kombination von Patches aus verschiedenen Dateien zu einem
sehr schnellen und unkomplizierten Prozess!
Wenn Sie in eine "Voice Library" einfigen, werden die neuen Voices vor den
ausgewahlten Patches eingefligt.
Ist kein Patch ausgewahlt, dann werden die neuen Patches am Ende der Liste
aufgenommen.

e Sortieren
Mit diesem Befehl kénnen Sie nur die ausgewdahlten Patches sortieren. Die
ausgewahlten Patches kénnen nach Bezeichnung, Kategorie oder Kommentar
sortiert werden.

¢ Remove Duplicates (Duplikate entfernen)
Dieser Befehl flhrt bei den ausgewahlten Patches das "Remove Duplikate"-
Kommando aus (Edit>Remove Duplicated). Es entfernt die gefundenen
doppelten Eintrége von Patches und zeigt einen Bericht dariber an.

e Properties (Eigenschaften)
Mit diesem Befehl kénnen die Eigenschaften der ausgewahlten Patches
bearbeitet werden.
Die Eigenschaften eines Patches sind:

o Name (Bezeichnung): Patch-Bezeichnung
o Category (Kategorie): Patch Kategorie (nicht fiir Performances)
o Comment (Kommentar): kurze Beschreibung, um den Patch leicht

zu erkennen

Bitte beachten Sie, dass bei mehreren ausgewéhlten Patches die Anderungen fir
alle Patches auf einmal gemacht werden. Sie kénnen aber auch nur einige Felder
verandern, so dass der Rest unverandert bleibt.

i~ Y
Patch Properties |ﬁ|

Patch Properties

Name:
<keep:=

Category:

| <keep>

Comments:

Sounds from Collection I

oK ][ Cancel ]
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Zogern Sie nicht mich fir Anregungen, Kommentare, Wiinsche, Fehlerberichte zu
kontaktieren:

info@jmelas.gr

Fir Updates und Neuigkeiten besuchen Sie bitte meine Seite:

http://www.jmelas.gr/motif

Mit freundlichem GruB,
John Melas

Deutsche Ubersetzung:
(ohne Gewadhr)

Manfred Drasch
ManfredJD@web.de
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Wichtiger Hinweis:

Falls Sie das "Synthesizerparameter-Handbuch" noch nicht besitzen, dann empfehle ich
unbedingt, es vom Hersteller des MX49/MX61 Synthesizers herunter zu laden!

Es erklart ausfuhrlich alle Begriffe und Parameter des Synthesizers.

Was bedeutet denn das schon wieder?

Stichwort Bedeutung

Performance In einer Performance werden mehrere Voices miteinander
kombiniert (max. 128 Performances)

Patch Voice, Schlagzeug-Voice oder Performance

Voice Enthalt elektroakustische Elemente zum Erzeugen des

Klangs eines bestimmten Musikinstruments.
Es gibt zwei Arten von internen Voices:
o Normale Voices (Normal Voices)

o Schlagzeug-Voices (Drum-Voices)

User-Voice Wird im User-Speicher des Instruments abgelegt und kann
Uberschrieben werden
(max. 128 Normale Voices und 8 Schlagzeug-Voices)

Bank Zusammengefasste Voices

Editpuffer Temporarer Speicher im MX49/61, Inhalt geht beim
(Bearbeitungspuffer) Ausschalten verloren

parent-Patch Ein Patch nutzt einen anderen Patch

(Eltern-Patch)

child-Patch Ein Patch wird von einem anderen Patch verwendet

(Kind-Patch)

Information

Die in diesem Handbuch erwahnten Firmen- und Produktnamen sind Warenzeichen bzw.
eingetragene Warenzeichen der betreffenden Firmen.
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